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Welcome to  GCE!

Congratulations on your use of the Net3 Gateway Configuration Editor (GCE) from ETC.

This software offers a great range of features including sortable table views of all your 
gateways, individual tabs for different types of gateways, as well as storage of your 
configuration on your computer’s hard drive. GCE is perfect for configuring your Net3 
devices (DMX, Show Control and I/O Gateways) in any venue, remotely over a standard 
Ethernet network.

Why d id  ETC make  GCE?

Net3 Gateway Configuration Editor (GCE) was made to configure Net3 gateways (DMX, 
Show Control, & IO) in the same way that NCE (Network Configuration Editor) was made 
to configure ETCNet2 devices.

While NCE & GCE share many of the same characteristics, and in some cases even some 
of the same devices (Net3 DMX Gateways but in different software modes), they use a 
different set of protocols to get the communication done.

GCE uses Net3, while NCE used ETCNet2. Ooooo, one number higher you say... well, yes. 
And more.

Read on to learn more about Net3.

What  i s  Ne t3?

Net3 is a protocol suite based on the ESTA established industry open standard ACN 
(Architecture for Control Networks).

In essence, Net3 is ACN. It is ETC’s implementation, so it will play just fine on an ACN 
system. However, the Net3 part is where we’ve added the extra bits that people have come 
to expect from ETC above and beyond baseline interoperability.

Additionally, labeling something as Net3 does not mean it’s exclusive to ETC. It just means 
that it conforms to the guidelines we’ve laid down for our equipment. For a device or piece 
of software to carry the Net3 name means that it will function "better together" with other 
Net3 gear.

How wou ld  you  use  GCE?

There are a couple primary uses for GCE.

• To view your gateway’s online status and current configuration.

• To configure your gateways.

• To store/retrieve that configuration information on/from your computer.

• To update your gateway’s software.

There are several other combinations of those premises, but those are some of the main 
functions.
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Add i t i ona l  He lp  f rom ETC

If you are having difficulties, your most convenient resources are the references given in 
this documentation. To search more widely, try the ETC Web site at www.etcconnect.com. 
You can ask other users for advice on the ETC Community Forums at 
www.etcconnect.com/community.

If none of these resources is sufficient, contact ETC Technical Services directly at one of 
the offices identified below. Emergency service is available from all ETC offices outside of 
normal business hours.
When calling for help, please have the following information handy: 

• Console model and serial number (located on back panel)

• Dimmer manufacturer and installation type

• Network equipment (ETC gateways, network switches, etc.)

• Other components in your system (Unison®, other consoles, etc.)

Amer icas Un i ted  K ingdom
Electronic Theatre Controls Inc. Electronic Theatre Controls Ltd.
Technical Services Department Technical Services Department
3031 Pleasant View Road 26-28 Victoria Industrial Estate
Middleton, WI 53562 Victoria Road, 
800-775-4382 (USA, toll-free) London W3 6UU England
+1-608 831-4116 +44 (0)20 8896 1000
service@etcconnect.com service@etceurope.com

Asia Germ any
Electronic Theatre Controls Asia, Ltd. Electronic Theatre Controls GmbH
Technical Services Department Technical Services Department
Room 1801, 18/F Ohmstrasse 3
Tower 1, Phase 1 Enterprise Square 83607 Holzkirchen, Germany
9 Sheung Yuet Road +49 (80 24) 47 00-0
Kowloon Bay, Kowloon, Hong Kong techserv-hoki@etcconnect.com
+852 2799 1220
service@etcasia.com

http://www.etcconnect.com/
http://www.etcconnect.com/community
mailto:service@etcconnect.com
mailto:service@etceurope.com
mailto:techserv-hoki@etcconnect.com
mailto:service@etcasia.com
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Sect ion  1 :  Compute r  M in imum Requ i rements

These minimum requirements are for a personal computer running Net3 Gateway 
Configuration Editor (GCE). 

• 1GHz or better compatible processor

• 512MB RAM

• Screen resolution of 1024x768 or greater

• Windows XP Professional (Vista is not currently supported - meaning it has not been 
tested. In limited use, it seems to run fine.)

Sect ion  2 :  Sof tware  Ins ta l l a t i on

This installer installs the GCE application, Net3 Services (Address Service-DHCP, Update 
Service-TFTP, Time Service-SNTP) as well as the software for the various gateways that 
GCE supports (Net3 DMX Four Port Gateway, Net3 DMX Two Port Gateway, Net3 Show 
Control Gateway, Net3 I/O Gateway)

Installation is quite simple, start by double-clicking the installer application.

Then follow the onscreen instructions on the installer. Below are the screens and the 
actions you will need to take.
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Your  Compute r ’s  Ne twork  Se t t ings

This section will explain how to configure the network setting for the computer that you will 
connect to your lighting network and use to run GCE.

Three  Network  Addresses  Opt ions
There are three network address options that can be used on a Net3 network.

• Static IP address

• Dynamic IP address (using a DHCP server)

• Automatic private IP address (Link-local IP address)   Not currently supported by all 
Net3 devices.

Static IP address is what you want if you are going to edit all of your device’s IP addresses 
manually.

Dynamic IP address is what you want if you just want a DHCP server to handle IP 
addressing for you (recommended). This system scales very well from small to large 
networks.

Automatic private IP address is what you want (once it’s supported) if you just want the 
devices to sort out their own IP addresses on the network. This system works well for small 
and medium sized networks.
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Set t ing  Your  Network  Set t ings
The following settings should allow you to go between a Net3 lighting network and your 
standard home or office network if you need to. Additionally, if there is a DHCP server 
running on your lighting network, it will automatically use that address service as well.

Select User configured to set up your lighting network IP address information.
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GCE Ne twork  Se lec t ion

When you run GCE for the first time, it will most likely ask you to choose a network interface 
(NIC). If it does not, it means that it detected only one network interface and has selected 
that one automatically.

It will see bluetooth and firewire interfaces as options along with a standard Ethernet 
interface and ask you to select one.

You can come back and select a different interface at any time.

Network  Serv ices  Tab

The network services tab is where you control the individual network services.

• Address Service (DHCP)

• Update Service (TFTP)

• Time Service (SNTP)

• Discovery Service (SLP)

A red "X" indicates the service is not currently running.

A green "checkmark" indicates the service is currently running.

When "Return services to previous state upon exit" is checked, it means that it will put each 
service back to the state it was before GCE was started. This also means that you will need 
to restart each service each time you start GCE.

When it is unchecked, the services will remain in whatever state you have configured them 
after GCE is stopped. This can cause problems (and is why this is not the default) if you 
leave the Address Service (DHCP) running and you connect this computer back to a 
company or home network. It will begin giving out IP addresses to other computers on your 
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network and could cause communication between computers to be disrupted.

Address  Serv ice
You should start this service (DHCP) if you want the other devices (consoles, gateways and 
other computers) to get their IP addresses from this computer.

The status of the service is given to the right of the "Start" button.

It will tell you if there is already a DHCP server running on the network somewhere. If there 
is, you should not start it on your computer. It is possible to run multiple DHCP servers on 
the same network, but that is an advanced configuration and not covered in this document.

Prior to starting your Address Service, you should click on the "Learn Network Services" 
button to learn the IP addresses of any devices already on the network. It will ask every 
device for its current IP address and put them in a list so it does not give out that IP address 
again to any other device.

You can not learn the network devices once the Address Service is running.

Update  Serv ice
You should start this service (TFTP) if you intend to send software to any of the Net3 
gateways or even to update software on older ETCNet2 nodes.

If you don’t have this service running when you tell the gateways to update software, the 
gateways will sit and wait until a TFTP server sends them software. It will look as the 
gateways just disappeared.

The status of the service is given to the right of the "Start" button.

Time Serv ice
You should start this service (SNTP) if you want this computer to receive or send time 
information over the network. Whether it sends or receives time is determined by the TIme 
Options tab in Advanced OptionsAdvanced Options (see below).

Discovery  Serv ice
The Discovery Service (SLP) is started by default when GCE is launched. GCE uses the 
discovery service to find the gateways on the network and to begin to communicate with 
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them.

You should leave this service running when using GCE.

There may be particular circumstances in troubleshooting that might require you to stop 
and restart this service.

Advanced  Opt ions
Clicking on the Advanced Options button opens another dialog box exposing the details of 
the various services and allows for further configuration.

Most lighting networks will not require editing these settings. More information is available 
via the online help in GCE.

Sect ion  3 :  Main  Menu

F i l e  Menu

Contains all options listed below.

New
This clears the configuration and starts a new one.

Open
Opens a standard "Open file..." dialog to load a previously saved configuration file.

Merge
This function will merge/add a previously saved configuration file to the currently loaded 
configuration (shown in the Configured Devices window).

If a duplicate is found while reading the configuration file, you are prompted to keep the 
existing entry (discarding the merging entry), overwrite the existing entry with the one being 
merged, or to keep the existing entry while also making a copy of the merging entry.

By default, a dialog opens to ask how you want to resolve any duplicate configurations. This 
can be disabled in Preferences. Once disabled, it will automatically do what your last choice 
was. The default is to "Keep the current entry".

See "Merge Dialog"

Save
This will save your currently loaded device configuration to your hard drive. 

Save  As . . .
This will save your currently loaded device configuration to your hard drive with the option 
to change the file name and the location.
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Preferences
Please see the Preferences topic.

Unprotec t  IP  Addresses . . .

The direct editing of IP addresses is password protected. It should be a rare occasion that 
you would need to edit any of the static IP address information of gateways, but if you do 
the password is "net3".

You can also change the password from that dialog box. 

Show Log F i le

Ex i t
Exits GCE and depending on the setting in the Network Services Tab, stops all of the Net3 
services that were started by GCE (by default) and exits the application.

Edi t  Menu

Inser t  New Dev ice  (C t r l+ I )
This menu item and its keyboard shortcut creates a new gateway of your choice in the 
Configured Devices table. The available types of gateways will vary depending on the 
gateway tab that is currently selected. If you are viewing DMX gateways, only the Two Port 
and the Four Port DMX gateways will be available as choices. The same goes for both the 
Show Control and the I/O Gateways. All gateways are available to be created when in the 
All Gateways tab.
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Dele te  Ent ry  (Cr t l+D)
This menu item and its keyboard shortcut deletes the selected gateway from either the 
Configured Devices table or the Online Devices table. If you delete a gateway from the 
Online devices table and you want to see it again, use the Refresh (Ctrl+R) command found 
in the Online menu.

Edi t  Dev ice  Patch
This brings up a screen to edit the Advanced Input Patch (AIP) of the selected gateway.

Edi t  Dev ice  Conf igura t ion  (Cr t l+E)
This menu option along with its keyboard shortcut (Crtl+E), double-clicking in the Status 
column, or right-clicking on any column of an entry will open a multi-tabbed dialog where 
you can view and edit any of the gateways properties.

See the individual gateway sections for additional details.

View Menu

Show/Hide  Conf igured  Dev ices
Selecting Show Device Configuration Table brings up the table showing the list of devices 
in the current configuration. If the Online Table is not visible on the main window, the 
Configuration Table takes up the entire window. If the Online Table is visible, the main 
window is divided equally among both visible tables. The menu item has a check mark 
when the table is visible, and no check mark when it is not visible.

Show/Hide  Onl ine  Dev ices
Selecting Show Online Devices Table brings up the table showing the list of devices 
discovered online. If the Configuration Table is not visible on the main window, the Online 
Devices Table takes up the entire window. If the Configuration Table is visible, the main 
window is divided equally among both visible tables. The menu item has a check mark 
when the table is visible and no check mark when it is not visible.

Onl ine  Menu

Apply  Conf igura t ion  to  Network
Selecting Apply Configuration to Network causes GCE to send the current configuration in 
the Configured Devices table to the matching online gateways in the Online Devices 
table.

Refresh
Selecting Refresh makes GCE update information about the Online Devices.

 If one or more rows are selected, GCE queries the corresponding gateways for their 
current property settings. If no devices are selected, then you are asked if you wish to 
Refresh All Devices. 

If you confirm Refresh All Devices, the online table is rebuilt from the Discovery Service 
(SLP) and all properties of discovered devices are updated.

Set  Network  Dev ice  Mode
Selecting Set Device Network Mode displays a dialog allowing you to set the network mode 
(Net2 or Net3) of the gateways found on the network.

See "Set Device Network Mode Dialog"
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Update  Dev ice  Sof tware
Selecting Upgrade Device Software tells the selected devices to get new software.

 If no devices are selected, you are asked if you want to upgrade all devices.

 If you confirm this action, all devices in the online table are sent a message telling them to 
get new software.

See "Update Gateway Software"

Reboot  Dev ices
Selecting Reboot Devices sends a soft reset command to the selected devices.

 If no devices are selected, you are asked if you want to reboot all devices.

 If you confirm, a message will be sent to all devices on the network telling them to execute 
a software reset. 

Network  Menu

Conf igure  Network  and  Serv ices  
Selecting Configure Network and Services reads the current state of the services available 
and will display the 3-tabbed Network Configuration dialog. Here you may select the 
primary and secondary NICs, start / stop and configure services and view their NIC settings.

See “GCE Network Selection” on page 7.

See “Network Services Tab” on page 7.

Hel p  Menu

Help  Top ics
Launches this online help system your default web browser.
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Legend
Displays all of the icons used in GCE and their meaning.

About  GCE
Provides detailed version and component information as well as contact information for 
ETC.
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Pre fe rences

The preferences dialog is accessed via GCE’s File menu

Settings made here persist after quitting GCE and will remain in effect for the next time you 
run GCE.

Copy Dev ice  Name 
Turned ON by default.

When this is turned on (checked), you will copy and overwrite any existing name when 
copying a config table entry onto an online device.

When this is turned off (unchecked), you will not copy the name while copying the rest of 
the config table entry settings onto an online device.

These options are useful either way depending on what you want to do. If you are just trying 
to use a single device entry to copy settings onto different devices, it is useful to copy the 
rest of the settings without changing all of the device’s name to the same one. Likewise, if 
you want to just copy a single configuration to a device and want to be sure that the name 
changes with the settings, then leave it in the default (on) setting.

Copy Dev ice  IP  Addresses
Turned OFF by default.

When this is turned off (unchecked), you will not copy the IP address information (IP 
address, Subnet mask & Gateway IP) while copying the rest of the config table entry 
settings onto an online device.

When this is turned on (checked), you will copy and overwrite any existing IP address 
information (IP address, Subnet mask & Gateway IP) when copying a config table entry 
onto an online device.

Auto  Connect  Dev ices
Turned ON by default.
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GCE has the ability to separately discover a device and connect to it (getting all of its 
properties & settings).

When Auto Connect is turned on, as soon as GCE discovers a device, it will connect to it 
automatically and get all of its relevant information. This is the way you would normally 
expect it to work and it works well for smaller systems.

It is useful to turn it off in large systems (100+ devices) to reduce the traffic and response 
time of GCE. In this mode, GCE will discover all of the devices and only connect to the ones 
you want to configure (by selecting the device in the online devices table and clicking on 
the Connect button that appears when Auto Connect is turned off).

Show F i le  Merge  Dupl ica te  Detec t ion  D ia log
Turned ON by default.

This enables a dialog to pop up and ask how you want to handle a duplicate device entry. 
You are given options to keep either entry. When this is turned off and a duplicate is 
detected, the new device entry (to be merged) replaces the existing device entry.

GCE Log Set t ings
Do not changes these unless directed to do so by ETC Technical Support personnel.

When updat ing  dev ice ,  do  not  show th is  d ia log  aga in
Turned OFF by default. 
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Sect ion  4 :  Main  D isp lay  Tabs

Al l  Ga teways

Displays only common properties from each gateway type.

Sta tus
Displays the current status of a given gateway. The icons will vary from the Configured 
Table to the Online Table. Below are the icons used for the different status messages in the 
tables.

These icons can be found in the Help>Legend in the Legend.
Name

Is the name given to the device. It can be set by the user to help tell the difference between 
the different gateways and their intended uses (as defined by the user).

Net3 DMX Gateways default to a unique name made up of the manufacturer (ETC), the 
gateway type (Net3GW4P) and the last half of its MAC address (00651b).An example is: 
ETCNet3GW4P00651b

Type  (o f  Dev ice )
Displays the type of gateway that it is. Examples are: DMX 4-Port Gateway, DMX 2-Port 
Gateway, Show Control Gateway and I/O Gateway. Other types may be added in the 
future.

IP  Address
Displays the IP address of the gateway.

IP  Mode
Displays whether the IP address has been assigned dynamically (for example via DHCP 
address server) or has manually been given a static IP address.
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DMX Gateways

Displays only the properties for Gateways

Sta tus
Displays the current status of a given gateway. The icons will vary from the Configured 
Table to the Online Table. Below are the icons used for the different status messages in the 
tables.

These icons can be found in the Help>Legend in the Legend.

Name
Is the name given to the device. It can be set by the user to help tell the difference between 
the different gateways and their intended uses (as defined by the user).

Net3 DMX Gateways default to a unique name made up of the manufacturer (ETC), the 
gateway type (Net3GW4P) and the last half of its MAC address (00651b).An example is: 
ETCNet3GW4P00651b

Type  (o f  Dev ice )
Displays the type of gateway that it is. Examples are: DMX 4-Port Gateway, DMX 2-Port 
Gateway, Show Control Gateway and I/O Gateway. Other types may be added in the 
future.

IP  Address
Displays the IP address of the gateway.

IP  Mode
Displays whether the IP address has been assigned dynamically (for example via DHCP 
address server) or has manually been given a static IP address.

Por t1  Mode
Displays the mode of the first DMX port (left to right looking at the rear of a Four-Port 
Gateway).

Available modes are:

Disabled - No DMX is received or transmitted.

>Input<- DMX is able to be received by this port.

<Output>- DMX is transmitted by this port.

Por t1  Un iverse
Displays the Universe number the DMX port will either receive or transmit on the network.

The range is from 1 to 65279.

Por t2  Mode
Displays the mode of the second DMX port (left to right looking at the rear of the unit).

Available modes are:

Disabled - No DMX is received or transmitted.

>Input<- DMX is able to be received by this port.

<Output>- DMX is transmitted by this port.

Por t2  Un iverse
Displays the Universe number the DMX port will either receive or transmit on.
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The range is from 1 to 65279.

Por t3  Mode
Displays the mode of the third DMX port (left to right looking at the rear of the unit).

Available modes are:

Disabled - No DMX is received or transmitted.

>Input<- DMX is able to be received by this port.

<Output>- DMX is transmitted by this port.

Por t3  Un iverse
Displays the Universe number the DMX port will either receive or transmit on.

The range is from 1 to 65279.

Por t4  Mode
Displays the mode of the fourth DMX port (left to right looking at the rear of the unit).

Available modes are:

Disabled - No DMX is received or transmitted.

>Input<- DMX is able to be received by this port.

<Output>- DMX is transmitted by this port.

Por t4  Un iverse  
Displays the Universe number the DMX port will either receive or transmit on.

The range is from 1 to 65279.

Show Cont ro l  Ga teways

Sta tus
Displays the current status of a given gateway. The icons will vary from the Configured 
Table to the Online Table. Below are the icons used for the different status messages in the 
tables.

These icons can be found in the Help>Legend in the Legend.

Name
Is the name given to the device. It can be set by the user to help tell the difference between 
the different gateways and their intended uses (as defined by the user).

Net3 DMX Gateways default to a unique name made up of the manufacturer (ETC), the 
gateway type (Net3GW4P) and the last half of its MAC address (00651b).An example is: 
ETCNet3GW4P00651b

Type  (o f  Dev ice )
Displays the type of gateway that it is. Examples are: DMX 4-Port Gateway, DMX 2-Port 
Gateway, Show Control Gateway and I/O Gateway. Other types may be added in the 
future.

IP  Address
Displays the IP address of the gateway.

IP  Mode
Displays whether the IP address has been assigned dynamically (for example via DHCP 
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address server) or has manually been given a static IP address.

SMPTE ID
A SMPTE port on a gateway only acts as an input port converting SMPTE signal into an 
ACN stream.

SMPTE ID displays the ID that the SMPTE received via the SMPTE port is tagged with for 
transmission via ACN over Ethernet to a console or similar device to receive. That receiving 
device must also be set to the same SMPTE ID as the SMPTE port you want to receive 
SMPTE from.

The range is from 0 to 32.

MIDI  Rx  ID
The MIDI Rx port on a gateway acts as an input port converting MIDI signal into an ACN 
stream.

MIDI Rx ID displays the ID that the MIDI received via the MIDI Rx port is tagged with for 
transmission via ACN over Ethernet to a console or similar device to receive. That receiving 
device must also be set to the same MIDI ID as the MIDI Rx port you want to receive MIDI 
from.

The range is from 0 to 32.

MIDI  Tx  ID
The MIDI Tx port on a gateway acts as an output port converting an ACN stream into a MIDI 
signal.

MIDI Tx ID displays the ID that the MIDI received via ACN is tagged from a transmitting 
console or similar device. That transmitting device must also be set to the same MIDI ID as 
the MIDI Tx port you want to send MIDI to.

The range is from 0 to 32.
I/O Gateways

Sta tus
Displays the current status of a given gateway. The icons will vary from the Configured 
Table to the Online Table. Below are the icons used for the different status messages in the 
tables.

These icons can be found in the Help>Legend in the Legend.

Name
Is the name given to the device. It can be set by the user to help tell the difference between 
the different gateways and their intended uses (as defined by the user).

Net3 DMX Gateways default to a unique name made up of the manufacturer (ETC), the 
gateway type (Net3GW4P) and the last half of its MAC address (00651b). An example is: 
ETCNet3GW4P00651b

Type  (o f  Dev ice )
Displays the type of gateway that it is. Examples are: DMX 4-Port Gateway, DMX 2-Port 
Gateway, Show Control Gateway and I/O Gateway. Other types may be added in the 
future.

IP  Address
Displays the IP address of the gateway.

IP  Mode
Displays whether the IP address has been assigned dynamically (for example via DHCP 
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address server) or has manually been given a static IP address.

Analog  ID
Displays the Analog Group ID.

The Group ID is similar in concept to a DMX Universe, except that you can have 65536 
addresses per Group ID. Each Analog input has an address (1 to 65536) within each 
Analog Group ID. Both the Analog Group ID and the Analog Address for a particular analog 
input is needed to access that information.

The Analog Group ID range is from 0 to 32.

Relay  ID
Displays the Relay Group ID.

The Group ID is similar in concept to a DMX Universe, except that you can have 65536 
addresses per Group ID. Each Relay output has an address (1 to 65536) within each Relay 
Group ID. Both the Relay Group ID and the Relay Address for a particular relay is needed 
to access/control that relay.

The Relay Group ID range is from 0 to 32.

Ser ia l  ID
Displays the Serial Group ID.

Serial Group ID also has Serial Address, but it is snot currently used. Only the Serial Group 
ID is used to identify a serial port on a gateway.

The Serial Group ID range is from 0 to 32.

Conf igured  &  On l ine  Dev ices  Tab les
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Conf igured  Dev ices  Tab le
This table displays the configuration information for gateways. This is the information that 
is saved when you save a configuration to disk. The Online Devices table information is not 
saved.

This is also where configuration files appear when they are opened.

Onl ine  Dev ices  Tab le
This table displays the devices/gateways that have been discovered online via the 
Discovery Service (SLP). This information is a "snapshot" in time from the last time GCE 
received information from each one of the gateways in the table. This is not a live updating 
table of the configuration properties. The only column that updates live is the status.

To update the properties in the Online Devices table, use Refresh (Crtl+r). See Main 
Menu>Online>Refresh

Dragging  &  Dropping
Dragging a row from the Configured Devices table and dropping it on an Online Devices 
table row updates the online device with all properties of the configuration device (except 
for possibly the name and IP settings. See "Preferences")

Dragging a row from the Online Devices table and dropping it on a Configured Devices 
table row updates the configuration information to match the settings of the online device. 
This will only happen if the devices are of the same type. The target row is Bound (appears 
with a green background) in the sense that it has a unique ID (CID) that points to/matches 
that of the online device.

Dragging a row from the Online Devices table and dropping it in an empty area of the 
Configured Devices table creates a new row that is an exact copy of the source row.

See "Preferences"

Dragging a row from the Configured Devices table and dropping it in an empty area in the 
Configured Devices table will result in the creation of a new row containing a copy of the 
source row with the exception that the unique ID (CID) property will not be copied.
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The  Bot tom Counte rs  &  Cont ro l s

This section covers the area circled in red below.

These are discussed in the order of left to right then down.

Gateway  Counters
On the bottom-left of the main screen is a frame containing a running total of the number of 
devices of known types that are currently online. These totals are broken down by DMX, 
Show Control & I/O Gateway types.

Show Conf igured  Dev ices
There is a check box that controls the Show Configured Devices Table. This table shows 
the list of devices in the current configuration. If the Online Table is not visible on the main 
window, the Configuration Table takes up the entire window. If the Online Table is visible, 
the main window is divided equally among both visible tables.

Show Onl ine  Dev ices
There is a check box that controls the Show Online Devices Table. This table showing the 
list of devices discovered online. If the Configuration Table is not visible on the main 
window, the Online Devices Table takes up the entire window. If the Configuration Table is 
visible, the main window is divided equally among both visible tables.

Discover  Dev ices
On the bottom-right of the main screen there is a check box that controls the Discovery 
Service (SLP), effectively freezing the list of gateways in the Online Devices table. When 
the Discovery service (SLP) is turned off, you will not be able to see if a new gateway has 
come online. You can not change the properties of a gateway in the online table if it has 
gone offline. The configuration for the gateway is still editable in the configuration table if 
there is a bound configuration record for it. That configuration may be applied at a later time 
when the gateway is online.

When GCE is terminated and restarted, discovery will be enabled by default and the 
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previous list of online devices will be lost.

Tota l  Number  o f  Dev ices  Connected
On the very bottom-right corner, there is a running total of all of the gateways found and 
connected to by GCE.

Ri ght -C l i ck  Menus

The main screen supports right click menus as follow. 

A right-click when the mouse is over the Configured Devices table:

• Add Device – same as Edit menu’s Insert New Device functionality.

• Edit Device Properties – same as Edit menu’s Edit Device Configuration functionality.

• Delete Entry – delete the selected row entry.

• Apply – selecting this menu item causes GCE to apply configuration settings to the 
online device corresponding to the row with focus or the selected rows.

A right-click when the mouse is over the Online Devices table:

• Edit Device Properties – same as Edit menu’s Edit Device Configuration functionality.

• Delete Entry – delete the selected row entry.

• Refresh – same as the Online Devices menu’s Refresh function.

• Identify – selecting this menu choice causes a message to be sent to the device(s) 
represented by the selection or focus in the table. The message is to trigger the identify 
functionality of the selected devices which is typically to flash the LCD back light of the 
device.

• Deleting an entry (via Cut/Delete) from the Online Devices table can be temporary. To 
make deleted entries immediately reappear, select Online, Refresh from the main 
menu.
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Merge  D ia log

While merging a configuration file with the contents of the Configured Devices table, a 
duplicate may be found. This dialog will offer the user 3 choices at to how this conflict might 
be resolved.

Step 1: Keep the current Configured Devices table entry (discard the merging duplicate 
entry.)

Step 2: Overwrite the current Configured Devices table entry.
Step 3: Insert a copy of the merging entry (contains a null CID and is not bound.)

If you decide not to show this dialog again, the default choice is the last selected choice 
made in this dialog ("Keep the current entry" is the default) You may change the preference 
for this dialog to be shown by changing the Show file merge duplicate detection dialog 
check-box in the Preferences dialog.
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Set  Dev ice  Ne twork  Mode  D ia log

This dialog displays the current mode of operation, device name, IP Address, device type, 
software version and CID of all Net3 online devices including Net3 devices operating in 
Net2 mode.

This dialog provides buttons to allow the user to send a command to one or more nodes 
telling them to switch Net2 nodes to ACN mode or switch ACN nodes to Net2 mode.

Swi tch  to  ACN (Net3 )
Pressing the Switch to ACN button tells the selected devices to change their operating 
mode to ACN/Net3.

If no devices are selected, you are asked if you want to change the mode of all devices.

 If you confirm this action, all devices in the online table are sent a message telling them to 
change their mode of operation to ACN/Net3.

Swi tch  to  Net2
Pressing the Switch to Net2 button tells the selected devices to change their operating 
mode to ETCNet2.

If no devices are selected, you are asked if you want to change the mode of all devices.

 If you confirm this action, all devices in the online table are sent a message telling them to 
change their mode of operation to ETCNet2.

Update  Sof tware
Pressing the Update Software button tells the selected devices to get new software. This 
works for devices both in Net2 mode and ACN/Net3 mode.

If no devices are selected, you are asked if you want to upgrade all devices.

 If you confirm this action, all devices in the online table are sent a message telling them to 
get new software.

See “Update Gateway Software” on page 53.
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Sect ion  5 :  Conf igu r ing  DMX Gateways

This dialog contains multiple tabs used for setting the writable properties and displaying the 
read-only properties of a Net3 DMX Gateway.

DMX Gateway  Iden t i t y  Tab

This tab of the DMX Gateway configuration dialog displays the general settings for Net3 
DMX Gateways.

Sof tware  Vers ion  (D isp lay  on ly )
This displays the current full version number of software loaded in the gateway. The first 
three digits (1.0.0) are considered the normal software version number and the last three 
are internal development numbers.

Name
The name of the gateway can be changed here. If the name is blank or the default 
generated name (for example ETCNet3GW4P00651b), then the actual gateway hardware 
will display its IP address on its LCD. Be aware that the Gateway LCD is only capable of 
displaying the first 20 characters of a name. You can assign a name that is longer, but it will 
be truncated by the display.
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Network  Addresses
IP addresses are not editable unless you have enabled their editing by entering the 
password in the IP Settings dialog. You can open that dialog from here by clicking on the 
button with the padlock icon.

Once you’ve enabled editing IP address information, you can change the settings for Static 
IP address and Dynamic IP address. If you choose static IP address, you can edit the 
network address fields of IP address, Subnet Mask and Gateway IP address.

TFTP Server  Network  Address
This is where you can edit the TFTP Server Network IP address that is stored in the Net3 
gateway. This IP address is used (if chosen in the update software dialog) to request 
software from a TFTP server (update service) that is expected to be running at that IP 
address.

When editing an Online Devices table row, Flash Backlight, Update Software, Reboot 
Device, Reset to Default & Reset Dynamic IP buttons all act immediately on the selected 
gateway.

Ident i fy  Gateway /F lash  Back l ight
This function can be used to easily locate a specific gateway in an equipment rack or any 
other location where you can see the LCD screens of the gateways.

Enter the amount of time in seconds and click on Flash Backlight. The LCD backlight of the 
gateway you are connected to will flash on and off for the specified amount of time and 
return the LCD backlight to its previous state.

Update  Sof tware
Pressing the Update Software button tells the selected devices to get new software from 
the IP address specified in the TFTP Server Network Address field.

Upon downloading the software the gateway will reboot.

Reboot  Dev ice
Clicking this button sends a message to the current gateway telling it to reboot. This is a 
soft-reboot.

Reset  to  Defau l ts
Clicking this button tells the gateway to restore to factory defaults on all properties and 
reboot.

Reset  Dynamic  IP  (Renew DHCP Lease)
Clicking this button deletes the current dynamic IP address information and reboots the 
gateway. Upon booting, the gateway will request a new dynamic IP address from an 
address service (DHCP Server).

N o t e : If you want to turn on the LCD backlight on DMX gateways, you will need to 
append the name of the gateway with ":on". You can also set it to ":off" which will 
prevent the backlight from turning on even when moving though the menu. It also 
supports ":auto" which is the same as having nothing appended to the name. In 
auto mode, the backlight will come on with the first menu button press and turn off 
after the backlight times out.
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DMX Gateway  DMX Tab

Clicking on this tab of the DMX Gateway configuration dialog displays the DMX port settings 
for Net3 DMX Gateways.

Name (D isp lay  on ly )
The name of the gateway is displayed here.

IP  Address  (D isp lay  on ly )
Displays the IP address of the gateway.

DMX Por ts
This area displays the four ports on the DMX gateway. If you are configuring a Two-Port 
Gateway, Ports 3 and 4 are grayed out.

ACN Universe  Number
Displays the Universe number the DMX port will either receive or transmit on the network.

The range is from 1 to 65279.

DMX Por t  Mode
Displays the mode of the DMX port.

Available modes are:

Disabled - No DMX is received or transmitted.
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>Input< - DMX is able to be received by this port.

<Output> - DMX is transmitted by this port.

DMX Por t  Output  Rate
Displays the output rate of the DMX port.

Available modes are:

Maximum- (Default) This is the maximum rate the DMX port can generate. This speed is 
typically 44Hz (refreshes 44 times a second).

Fast, Medium, Slow - These are varying slower speeds to better accommodate legacy 
DMX devices that may not be able to handle the full DMX refresh rate.

Synced - This setting matches the DMX output rate with the incoming sACN data rate. This 
is significant for use with some moving lights. In the unlikely event that a DMX Gateway 
drops a packet of DMX data from the network, it will simply send a duplicate of the previous 
DMX packet out on the DMX line. This works great for dimmers, but can adversely affect 
the movement/timing algorithm of some moving lights causing them to throw off their 
calculations momentarily resulting in uneven movement. Setting the port to Synced will 
cause the DMX port to wait for the next sACN packet before sending out the next DMX 
packet. This tends to work much better for the moving lights that may be affected by a 
duplicate DMX packet.

Streaming  ACN Proper t ies
These settings can only be made for a port set to input.

Pr ior i ty  Mode
Displays the priority mode of the DMX input port.

Available modes are:

Off - No priority is applied when creating the sACN data on the network.

Per Port - A single priority is used for all addresses on this port. It is set via the Port Priority 
field.

Per Address - A separate priority is available for each address on this port. It is set via the 
Per-Port Priority edit button.

Por t  Pr io r i ty
If the above Priority 
Mode is set to 
Per-Port, this is the 
port priority that is 
assigned to all address 
input on this DMX port.

Per -Address  Pr io r i ty
Clicking on the Edit 
button for this property 
opens the dialog box 
below for you to set the 
individual address 
priority values.
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Advanced  Input  Pa tch  
(A IP )

Clicking on the Edit 
button for this property 
opens the dialog box 
below for you to set the 
individual address 
patch assignments.

See “DMX Gateway 
AIP Tab” on page 33.

Hold  Last  Look  T ime 
(sec )  (D isp lay  Only )

This displays the Hold 
Last Look Time in 
seconds from the Data 
Loss Behavior dialog.

This setting show the 
amount of time a port 
will continue to hold the 
last received data 
packet and continue to 
generate output based 
on that level 
information.

RDM Enable  (D isp lay  Only )
RDM is not currently supported in the Net3 DMX Gateway.
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Data  Loss  Behav ior
Clicking on the Data Loss Behavior button opens the dialog box below for you to set the 
individual port data loss behaviors.

The fields for each port are laid out in a logical manner beginning with the top most (Hold 
Last Look Forever) down to the last (Data Loss Port Disable). This is the order in which they 
are logically applied to the DMX ports.

Name (D isp lay  on ly )
The name of the gateway is displayed here.

IP Address  (D isp lay  on ly )
Displays the IP address of the gateway.

Hold  Las t  Look  Forever
Not checked by default.

When checked/enabled, this will continue to repeat the last valid data until the until it is reset 
or valid data returns.

When the port is set to be a DMX output port, it means that it takes the last valid sACN 
packet and continues to output DMX.

N o t e : Recommended. data loss settings for moving lights:
Hold Last Look Forever=Not Checked
Hold Last Look Time=0 or your preference
Data Loss Fade Enable=Not Checked
Data Loss Port Disable=Checked

These settings allow the individual DMX device(s) own data loss behaviors to 
function without interference from the gateway’s settings.
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When the port is set to be a DMX input port, it means that it takes the last valid DMX packet 
and continues to put that level information out on the network.

Hold  Las t  Look  T ime  (sec )
180 seconds (3 minutes) by default. (only available if Hold Last Look Forever is not 
checked/enabled)

The port will continue to repeat the last valid data until the time specified is up.

When the port is set to be a DMX output port, it means that it takes the last valid sACN 
packet and continues to output DMX.

When the port is set to be a DMX input port, it means that it takes the last valid DMX packet 
and continues to put that level information out on the network.

Data  Loss  Fade  Enab le
Checked by default. (only available if Hold Last Look Forever is not checked/enabled)

When checked/enabled, this setting causes the DMX level information to fade to zero (0) 
as specified in the next field after the Hold Last Look Time has expired.

Data  Loss  Fade  T ime  (sec )
5 seconds by default. (only available if Hold Last Look Forever is not checked/enabled)

Data Loss Fade Time specifies the amount of time that will be used by Data Loss Fade 
Enable to fade to zero (0) 

Data  Loss  Por t  D isab le
Checked by default. (only available if Hold Last Look Forever is not checked/enabled)

After all other data loss behavior settings have been executed, this setting determines 
whether or not the DMX port is shut off (no more DMX output) or if it will continue to output 
level information with all levels at zero (0).

RDM Proper t ies
RDM is not currently supported in the Net3 DMX Gateway.
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DMX Gateway  A IP  Tab

Clicking on the AIP tab opens the dialog box below for you to set the individual address 
patch assignments. 

Advanced  Input  Pa tch  (A IP)
If you need a highly customized input patch, this is the place to go. You can set each DMX 
input address to go to any specific sACN address (via Port/Offset notation as shown 
above). You can also set each DMX input address to multiple sACN addresses by either 
appending to the current patch or via manual editing of a specific location.

Double-click on a port address to edit that field.

Name (D isp lay  on ly )
The name of the gateway is displayed here.

IP Address  (D isp lay  on ly )
Displays the IP address of the gateway.
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Copy From Por t
Clicking on this button open the dialog show below. From this dialog, you specify the 
gateway and port for the AIP you want to copy to the gateway and port that you are currently 
editing.

One- to -One  Patch
One-to-One Patch sets a one-to-one patch 
for this DMX universe.

You must specify an ACN Universe number 
(1 to 65279) to patch, however if you leave 
the offset blank it will use 1 automatically.

If you choose to append this patch action, 
you will add it to the current patch information 
for the AIP. If left unchecked, the current 
patch will be cleared and replaced with the 
result of this patch action.

Range  Patch
Range Patch is a tool to set sequential address patches 
over a specified range, starting point, and length of 
patch.

ACN Universe Number sets the ACN universe to be 
patched to the DMX addresses.

ACN Universe Offset sets the starting place within the 
ACN universe to be patched.

DMX Start Address sets the first DMX address for the 
patch to be applied to.

Range Length sets how many DMX addresses will be 
affected.

DMX End Address sets the last DMX address to be 
affected by the patch.

Setting either Range Length or DMX End Address will 
auto-fill the other setting.

If you choose to append this patch action, you will add 
it to the current patch information for the AIP. If left unchecked, the current patch will be 
cleared and replaced with the result of this patch action.

Clear  Pa tch
Clicking this button immediately clears the entire AIP patch for this port.
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DMX Gateway  About  Tab

Clicking on this tab of the DMX Gateway configuration dialog displays an information only 
tab for Net3 DMX Gateways.

Nothing on this page can be edited or changed.

Name (D isp lay  on ly )
This field displays the current name of the gateway.

IP Address  (D isp lay  on ly )
This field displays the IP address of the gateway.

Hardware  Vers ion
This field displays the hardware revision level for this gateway.

Appl ica t ion  Vers ion
This is the same as the Software Version

This displays the current full version number of software loaded in the gateway. The first 
three digits (1.0.0) are considered the normal software version number and the last three 
are internal development numbers.

Model  Name
This field displays the model name for this gateway.
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Manufac turer
This field displays who the manufacturer is for this gateway.

Defau l t  Name
This field displays the calculated default name for this gateway. If you reset the gateway to 
factory defaults, it would have this name.

 If the name is blank or the default generated name (for example ETCNet3GW4P00651b), 
then the actual gateway hardware will display its IP address on its LCD.

TFTP F i lename
This field displays the filename for the software it will ask to download from a TFTP server 
when told to update software.

Por t  Type
This field displays the type of port installed in a DMX gateway. The following are the 
available options:

XLR male - A 5-pin XLR male connector, typically used for DMX input defaults the port to 
an input port.

XLR female - A 5-pin XLR female connetor, typically use for DMX output, defaults the port 
to an output port.

RS-485 other - Either a terminal strip connector or an RJ-45 connector, defaults the port to 
an output port.

Empty - indicates that no DMX port is currently installed, defaults the port to disabled.

CID
The CID is a giant 128-bit number that is a completely unique ID number to this ACN 
device. No other ACN device will have a duplicate CID.

DCID
The DCID is a giant 128-bit number that identifies a type of device with particular set of 
functions. Those functions may change with software versions and therefore change the 
DCID.
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Sect ion  6 :  Conf igu r ing  Show Con t ro l  Ga teways

This dialog contains multiple tabs used for setting the writable properties and displaying the 
read-only properties of a Show Control Gateway.

When this dialog is opened from the Configured Devices table, selecting the OK button 
saves changes to the configuration record only and does not make any changes to any 
online device.

When the dialog is opened from the Online Devices table, selecting the OK button sends 
changes to the online device only and does not affect any bound entries in the Configured 
Devices table.

The Cancel button ignores any changes that were made and closes the dialog.
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Show Cont ro l  Ga teway  Iden t i t y  Tab

This tab of the Show Control Gateway configuration dialog displays the general settings for 
Net3 Show Control Gateways.

Sof tware  Vers ion  (D isp lay  on ly )
This displays the current full version number of software loaded in the gateway. The first 
three digits (1.0.0) are considered the normal software version number and the last three 
are internal development numbers.

Name
The name of the gateway can be changed here. If the name is blank or the default 
generated name (for example ETCNet3GW4P00651b), then the actual gateway hardware 
will display its IP address on its LCD. Be aware that the Gateway LCD is only capable of 
displaying the first 20 characters of a name. You can assign a name that is longer, but it will 
be truncated by the display.

Network  Addresses
IP addresses are not editable unless you have enabled their editing by entering the 
password in the IP Settings dialog. You can open that dialog from here by clicking on the 
button with the padlock icon.

Once you’ve enabled editing IP address information, you can change the settings for Static 
IP address and Dynamic IP address. If you choose static IP address, you can edit the 
network address fields of IP address, Subnet Mask and Gateway IP address.
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TFTP Server  Network  Address
This is where you can edit the TFTP Server Network IP address that is stored in the Net3 
gateway. This IP address is used (if chosen in the update software dialog) to request 
software from a TFTP server (update service) that is expected to be running at that IP 
address.

Back l ight  On /Back l ight  Of f
Clicking on this button sends a command to turn on or turn off the LCD backlight on the front 
of the gateway.

The button text displays the action that will be taken when clicked.

When the backlight is turned off, it will still illuminate for menu button presses on the front 
panel of the gateway.

Update  Sof tware
Pressing the Update Software button tells the selected devices to get new software from 
the IP address specified in the TFTP Server Network Address field.

Upon downloading the software the gateway will reboot.

Reboot  Dev ice
Clicking this button sends a message to the current gateway telling it to reboot. This is a 
soft-reboot.

Reset  Dynamic  IP  (Renew DHCP Lease)
Clicking this button deletes the current dynamic IP address information and reboots the 
gateway. Upon booting, the gateway will request a new dynamic IP address from an 
address service (DHCP Server).

N o t e : When editing an Online Devices table row, Backlight On/Off, Update Software, 
Reboot Device, Reset to Default & Reset Dynamic IP buttons all act immediately 
on the selected gateway.
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Show Cont ro l  Ga teway  MID I /SMPTE Tab

Clicking on this tab of the Show Control Gateway configuration dialog displays the SMPTE 
and MIDI port settings for Net3 Show Control Gateways.

Name (D isp lay  on ly )
The name of the gateway is displayed here.

IP Address  (D isp lay  on ly )
Displays the IP address of the gateway.

SMPTE ID
Defaults to a group ID of 1.

A SMPTE port on a gateway only acts as an input port converting SMPTE signal into an 
ACN stream.

SMPTE ID displays the ID that the SMPTE received via the SMPTE port is tagged with for 
transmission via ACN over Ethernet to a console or similar device to receive. That receiving 
device must also be set to the same SMPTE ID as the SMPTE port you want to receive 
SMPTE from.

The range is from 0 to 32.

MIDI  Rx  ID
Defaults to a group ID of 1.

The MIDI Rx port on a gateway acts as an input port converting MIDI signal into an ACN 



41 Gateway Configuration Editor (GCE) v1.0 User Manual

stream.

MIDI Rx ID displays the ID that the MIDI received via the MIDI Rx port is tagged with for 
transmission via ACN over Ethernet to a console or similar device to receive

This MIDI Rx ID must match the MIDI Tx ID of the device you are intending on getting the 
MIDI information from.

The range is from 0 to 32.

MIDI  Tx  ID
Defaults to a group ID of 2.

The MIDI Tx port on a gateway acts as an output port converting an ACN stream into a MIDI 
signal.

MIDI Tx ID displays the ID that the MIDI received via ACN is tagged from a transmitting 
console or similar device.

This MIDI Tx ID must match the MIDI Rx ID of the device you are intending on sending the 
MIDI information to.

The range is from 0 to 32.

Show Cont ro l  Ga teway  About  Tab

Clicking on this tab of the DMX Gateway configuration dialog displays an information only 
tab for Net3 DMX Gateways.

Nothing on this page can be edited or changed.
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Name (D isp lay  on ly )
This field displays the current name of the gateway.

IP Address  (D isp lay  on ly )
This field displays the IP address of the gateway.

Ser ia l  Number
This field displays the serial number for this gateway.

Hardware  Vers ion
This field displays the hardware revision level for this gateway.

Appl ica t ion  Vers ion
This is the same as the Software Version

This displays the current full version number of software loaded in the gateway. The first 
three digits (1.0.0) are considered the normal software version number and the last three 
are internal development numbers.

Model  Name
This field displays the model name for this gateway.

Manufac turer
This field displays who the manufacturer is for this gateway.

MIDI  T ime F ie lds
This section displays the MIDI timecode values for Hours, Minutes, Seconds and Frames 
as those fields were read by GCE at the time of the last connection.

These are not "live" fields do not automatically update with new/ current timecode 
information.

SMPTE T ime F ie lds
This section displays the SMPTE timecode values for Hours, Minutes, Seconds and 
Frames as those fields were read by GCE at the time of the last connection.

These are not "live" fields do not automatically update with new/ current timecode 
information.

CID
The CID is a giant 128-bit number that is a completely unique ID number to this ACN 
device. No other ACN device will have a duplicate CID.

DCID
The DCID is a giant 128-bit number that identifies a type of device with particular set of 
functions. Those functions may change with software versions and therefore change the 
DCID.
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Sect ion  7 :  Conf igu r ing  I /O  Gateways

This dialog contains multiple tabs used for setting the writable properties and displaying the 
read-only properties of an I/O Gateway.

When this dialog is opened from the Configured Devices table, selecting the OK button 
saves changes to the configuration record only and does not make any changes to any 
online device.

When the dialog is opened from the Online Devices table, selecting the OK button sends 
changes to the online device only and does not affect any bound entries in the Configured 
Devices table.

The Cancel button ignores any changes that were made and closes the dialog.
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I /O  Ga tew ay  Iden t i t y  T ab

This tab of the I/O Gateway configuration dialog displays the general settings for Net3 I/O 
Gateways.

Sof tware  Vers ion  (D isp lay  on ly )
This displays the current full version number of software loaded in the gateway. The first 
three digits (1.0.0) are considered the normal software version number and the last three 
are internal development numbers.

Name
The name of the gateway can be changed here. If the name is blank or the default 
generated name (for example ETCNet3GW4P00651b), then the actual gateway hardware 
will display its IP address on its LCD. Be aware that the Gateway LCD is only capable of 
displaying the first 20 characters of a name. You can assign a name that is longer, but it will 
be truncated by the display.

Network  Addresses
IP addresses are not editable unless you have enabled their editing by entering the 
password in the IP Settings dialog. You can open that dialog from here by clicking on the 
button with the padlock icon.

Once you’ve enabled editing IP address information, you can change the settings for Static 
IP address and Dynamic IP address. If you choose static IP address, you can edit the 
network address fields of IP address, Subnet mask and Gateway IP address.
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TFTP Server  Network  Address
This is where you can edit the TFTP Server Network IP address that is stored in the Net3 
gateway. This IP address is used (if chosen in the update software dialog) to request 
software from a TFTP server (update service) that is expected to be running at that IP 
address.

Back l ight  On /Back l ight  Of f
Clicking on this button sends a command to turn on or turn off the LCD backlight on the front 
of the gateway.

The button text displays the action that will be taken when clicked.

When the backlight is turned off, it will still illuminate for menu button presses on the front 
panel of the gateway.

Test  Re lays
This button only appears when you are editing an online I/O Gateway.

Clicking on the Test Relays button open the dialog shown below.

In this dialog, it will show you a snapshot of the state of the relays the last time GCE read 
information from the I/O Gateway. Clicking on any of the boxes will immediately open or 
close the associated relay and give you a way to test all of the relays.

Closing this Test Relays window will return all of the relays to their state prior to opening 
this window.

N o t e : When editing an Online Devices table row, Backlight On/Off, Update Software, 
Reboot Device, Reset to Default & Reset Dynamic IP buttons all act immediately 
on the selected gateway.
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Update  Sof tware
Pressing the Update Software button tells the selected devices to get new software from 
the IP address specified in the TFTP Server Network Address field.

Upon downloading the software the gateway will reboot.

Reboot  Dev ice
Clicking this button sends a message to the current gateway telling it to reboot. This is a 
soft-reboot.

Reset  Dynamic  IP  (Renew DHCP Lease)
Clicking this button deletes the current dynamic IP address information and reboots the 
gateway. Upon booting, the gateway will request a new dynamic IP address from an 
address service (DHCP Server).

I /O  Ga tew ay  Ana log  Tab

Clicking on this tab of the I/O Gateway configuration dialog displays the analog input port 
settings for Net3 I/O Gateways.

Name (D isp lay  on ly )
The name of the gateway is displayed here.

IP Address  (D isp lay  on ly )
Displays the IP address of the gateway.
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Analog  Group ID
Displays the Analog Group ID.

The Group ID is similar in concept to a DMX Universe, except that you can have 65536 
addresses per Group ID. Each Analog input has an address (1 to 65536) within each 
Analog Group ID. Both the Analog Group ID and the Analog Address for a particular analog 
input is needed to access that information.

The Analog Group ID range is from 0 to 32.

Analog  Input  Mode
This setting of either 0 to 10 Volts or On / Off configures inputs to be read in either an 
analog manner returning values between 0 and 10 or in a digital mode returning 0 or 255 
respectively. In either mode, you are measuring 0 to 10 Volts dc from an external source. 
The mode only changes how it is reported.

Analog  Addresses
Each Analog input has an address (1 to 65536) within each Analog Group ID. Both the 
Analog Group ID and the Analog Address for a particular analog input is needed to access 
that level.

The addresses default to a 1-to-1 patch, but can be configured to be anywhere in the 1 to 
65536 range.
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 I /O  Ga teway  Re lay  Tab

Clicking on this tab of the I/O Gateway configuration dialog displays the relay output 
(contact closure) port settings for Net3 I/O Gateways.

Name (D isp lay  on ly )
The name of the gateway is displayed here.

IP  Address  (D isp lay  on ly )
Displays the IP address of the gateway.

Relay  ID
Displays the Relay Group ID.

The Group ID is similar in concept to a DMX Universe, except that you can have 65536 
addresses per Group ID. Each Relay output has an address (1 to 65536) within each Relay 
Group ID. Both the Relay Group ID and the Relay Address for a particular relay is needed 
to access/control that relay.

The Relay Group ID range is from 0 to 32.

Relay  Addresses
Each relay output has an address (1 to 65536) within each Relay Group ID. Both the Relay 
Group ID and the Relay Address for a particular analog input is needed to access that relay.

The addresses default to a 1-to-1 patch, but can be configured to be anywhere in the 1 to 
65536 range.
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I /O  Ga tew ay  Ser ia l  Tab

Clicking on this tab of the I/O Gateway configuration dialog displays the RS-232 serial port 
settings for Net3 I/O Gateways.

Name (D isp lay  on ly )
The name of the gateway is displayed here.

IP Address  (D isp lay  on ly )
Displays the IP address of the gateway.

Ser ia l  Por t  Group   ID
Displays the Serial Group ID.

Serial Group ID also has Serial Address, but it is not currently used. Only the Serial Group 
ID is used to identify a serial port on a gateway.

The Serial Group ID range is from 0 to 32.

Ser ia l  Por t  Address
This field is not currently used.

Ser ia l  Proper t ies
9600bps, 8N1 None are the default settings for the serial port.

Baud Rate
The Baud Rate is the data transfer rate and refers to the number of bits per second. 
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Data  B i ts
Data Bits refers to the number of bits of data in a transferred byte. 

Par i ty
Parity refers to the even or oddness of the data.

Stop B i ts
Stop Bits refers to the extra bit’s worth of time to announce the end of asynchronous data 
transmission.

F low Cont ro l
Flow Control refers to whether the data is throttled by software or by hardware. It is the 
process of managing the rate of data transmission between two nodes. Flow control is 
important because it is possible for a sender to transmit information at a faster rate than the 
destination can receive and process it. This can happen if the receiver has a heavy traffic 
load in comparison to the sender, or if the receiver has less processing power than the 
sender. 

I /O  Ga tew ay  About  Tab

Clicking on this tab of the I/O Gateway configuration dialog displays an information only tab 
for Net3 I/O Gateways.

Nothing on this page can be edited or changed.
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Name (Display only)
This field displays the current name of the gateway.

IP Address  (D isp lay  on ly )
This field displays the IP address of the gateway.

Ser ia l  Number
This field displays the serial number for this gateway.

Hardware  Vers ion
This field displays the hardware revision level for this gateway.

Appl ica t ion  Vers ion
This is the same as the Software Version

This displays the current full version number of software loaded in the gateway. The first 
three digits (1.0.0) are considered the normal software version number and the last three 
are internal development numbers.

Model  Name
This field displays the model name for this gateway.

Manufac turer
This field displays who the manufacturer is for this gateway.

Analog  Inputs
This is shows a snapshot of the state of the analog input values when GCE last got the 
properties from this gateway. The values are displayed in the range of 0 to 255.

CID
The CID is a giant 128-bit number that is a completely unique ID number to this ACN 
device. No other ACN device will have a duplicate CID.

DCID
The DCID is a giant 128-bit number that identifies a type of device with particular set of 
functions. Those functions may change with software versions and therefore change the 
DCID.

Sect ion  8 :  How To  Top ics

These are a couple of quick topics to help you learn some basic but important tasks within 
GCE.

Conver t  Ga teways  F rom ETCN et2  Mode  to  Ne t3 /ACN Mode

First, it’s important to know that only certain gateways have the ability to switch between 
ETCNet2 and Net3 operational modes.

• The network devices that can include:

• Net3 Four-Port DMX Gateway
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• Net3 Two-Port DMX Gateway

• Net3 One-Port DMX Gateway

Some other network devices that cannot change between ETCNet2 and Net3 include:

• Net3 Show Control Gateway (Net3 only)

• Net3 I/O Gateway (Net3 only)

• ETCNet2 DMX Nodes (ETCNet2 only)

• ETCNet2 Video Node (ETCNet2 only)

To change the mode of gateways on your network:
Select Set Device Network Mode... from the Online menu.

Step 4: Select the devices you want to change (ctrl-click to select multiple gateways) or 
don’t select any to change them all at once. This dialog shows both Net3/ACN 
devices and ETCNet2 devices that are online. Net3/ACN devices are shown as 
ACN and ETCNet2 devices are shown as Net2.

Step 5: Click on the Switch to ACN button or the Switch to Net2 button to tell the 
gateways to reboot into their new operating mode.
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Update  Ga teway  So f tware

Updating gateway software involves selecting the gateways you want to update and telling 
them to request software from a TFTP server (update service). They will request the 
software, and if available, download it, confirm that it is all there and error-free, then begin 
to install it. Once done installing, the gateways will automatically reboot to begin using their 
new software.

Make  sure  you  have  a  TFTP server  runn ing
A TFTP server can be running in any of a couple different kinds of places.

• As part of GCE

• On a console as part of Net3 Services (Eos, Ion, Congo/jr)

• On a standalone computer running Net3 Services

Make sure you know where it is and if it’s running.

Since there are many ways of accomplishing this, we will only cover the TFTP server 
included with GCE.

Step 1: Start the TFTP server (update service).
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Step 2: Select Set Device Network Mode... from the Online menu.

Step 3: Select the devices you want to update (ctrl-click to select multiple gateways) or 
don’t select any to update them all at once. This dialog shows both Net3/ACN 
devices and ETCNet2 devices that are online. Net3/ACN devices are shown as 
ACN and ETCNet2 devices are shown as Net2.

Step 4: Click on the Update Software button.

N o t e : Updating software will tell both ETCNet2 devices and Net3 devices to get new 
software. This is the only place in GCE to see all of those devices at once.
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Step 5: Specify the location of the TFTP server in this dialog. Use the option shown 
below.

Step 6: Click OK to tell the gateways to download new software and reboot into it.

Save  Your  Conf igura t ion

The most important thing to know about saving a configuration file from GCE is that it only 
saves configuration information from the Configured Devices (top) table.

Step 1: To get gateway configuration information to the Configured Devices table, you 
must drag them there one at a time.
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Step 2: Once you have the devices you want to save showing in the Configured 
Devices table, select Save or Save As... from the File menu as shown.

Step 3: In the save window, give your file a name and click Save.
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Load  Your  Conf igura t ion

The most important thing to know about loading a configuration file in GCE is that it only 
loads the configuration information to the Configured Devices (top) table. It does not 
immediately send the configuration out to the gateways on the network.

Step 1: Select  Open... from the File menu as shown.

Step 2: Select the file you want to load and click Open.

Step 3: Once the configuration is loaded, you need to apply it to the devices online in one 
of two ways.
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Step 4: Drag individual device configuration rows (from Configured Devices) down to 
the targeted device (to Online Devices), either the same corresponding device 
or a different device you want to copy the configuration information on to.

Step 5: Select Apply Configuration to Network from the Online menu. This option 
sends the all of the configuration information from the Configured Devices table 
to the matching gateways in the Online Devices table.
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Sect ion  9 :  Th ings  To  Be  Aware  Of . . .

• Address Service (DHCP server): The user is responsible for setting the starting pool IP 
address (First Address) of their DHCP (Address) server. If the primary network 
interface does not match the starting pool IP address, the DHCP server may serve up 
addresses that cannot be reached.

• The NIC using the Update service (TFTP server) must have a Default Gateway IP 
defined in Windows Network Connections.

• No Net3 devices found… message displays before devices are found. This may 
confuse a user. GCE displays the message when no devices are in the table. The 
problem arises when the Discovery Service (SLP) is slow to report discovered devices 
to GCE. This is aggravated when Discovery Service (SLP) is started and stopped by 
GCE.

• GCE starts

• GCE starts the Discovery Service (SLP)

• GCE initializes the ACN libs (discovery and so on.)

• GCE displays the No Net3 devices found… message

• Discovery Service (SLP) reports discovered devices

• GCE removes the message and displays the devices reported by the Discovery 
Service (SLP).

• The time between 4 and 6 is when the message is shown, BEFORE the Discovery 
Service (SLP) reports any discovered devices.

• If a network interface card change happens outside of GCE, GCE will have to be 
restarted. For example, if a network cable is plugged in while GCE is running, GCE will 
display any discovered devices found on the newly plugged in network but will be 
unable to connect to them because the ACN libraries know notahing about that 
network.

Device Selection:

• Select: click on any cell in the row or click on the row header.

• Deselect: click in table white space (outside of any cell) or Ctrl-click the selected 
cell or row header.

• The property values seen in GCE are a snapshot of the state of the gateway at the time 
of (re)connection. The gateways do not update GCE unless GCE asks for the 
properties. This means that if gateway properties are changed by another computer or 
console, your local GCE will not be updated to display the latest state of the properties. 
The user must use Refresh’ to get up-to-date properties of a device.

• Disallow copy of IP address and mode values if the Online entry is dynamic. The user 
MUST explicitly change this via the Online table. If the user has turned off the showing 
of the Preferences dialog (unchecking the checkbox for When updating devices, do not 
show this dialog again.) they will not be notified that the drop could not make any IP 
address or mode changes.

• Cannot drag & drop more than one device at a time.

• Cannot update more than one device at a time unless choosing Online, Apply 
Configuration to Network which updates all "Online Devices" with their corresponding 
device entries from the Config Devices table.
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• Default password to edit IP addresses: net3

• The Copy From Port’ dialog in the DMX AIP edit dialog will not copy a newly edited, but 
unsaved, patch from a port in the same document. The configuration needs to be saved 
before the new edits would be available to be copied to a different port.

• Online> Apply Configuration to Network and Drag & Drop (from Config table to Online 
table) will do a blanket update of all properties based upon the current preferences. A 
right-click Apply’ will only update properties that are different based upon the current 
preferences.

• I/O (Contact Closure) Gateway

• Serial Address is not used by any known device.
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